
Using DART Karaoke Author
DART Karaoke Author allows you to synchronize the music with the song lyrics. Additionally it gives 
access to the remaining DART Karaoke Studio utilities, namely: 

DART DeVocalizer (a tool which will allow you to suppress the vocal part of the original recording), 
DART Karaoke Recorder/Player (utility which can be used to play DART Karaoke files and to record 

your own vocal performance), 
DART Karaoke Producer (allowing you to combine the devocalized soundtrack extracted from the 

original recording with your vocal contribution) 
and 

DART CD-Recorder (an application that will allow you to record from both analog and digital audio 
sources, and to create your own CD).
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Modifying system settings

Synchronization
The distance between the word Flags is limited from below by 100 milliseconds. To change this value type
in a new number in the Minimum word separation time box.

For an average person it takes approximately 400 milliseconds to react to the sound stimuli. To 
compensate for this ‘response delay’ the Flags dropped during playback are placed in a soundfile with a 
400 ms time shift. To change this time constant, modify the number shown in the Response delay box.

When the Tie cursor position to the active flag option is switched on, the cursor is ‘anchored’ to the 
active Flag - each time you select a new Flag the cursor jumps to the Flag position. Moreover, the position
of the cursor is automatically adjusted when the Flag is moved. The tie is broken each time you click 
outside the flagpole area. To remove the tie, switch this option off.

If the Move window during playback option is activated, the contents of the Soundfile Window is 
scrolled during playback to show the fragment which is played.

Zoom
If you check the AutoZoom box DART Karaoke Author will automatically change the zoom coefficient to 
such one which guarantees that all word Flags belonging to the same verse will be displayed in the 
Soundfile Window when synchronization level is set to word. If the AutoZoom box is left unchecked the 
zoom coefficient will remain constant unless you intentionally modify its value or change the 
synchronization level.
If necessary you can change the default zoom coefficients associated with different synchronization 
levels.

Frame
Depending on your preferences the Frame may be window-constrained (i.e., always situated inside the 
Soundfile Window) or unconstrained. Use the radio buttons to switch between these two options.



Managing DART Karaoke Author sessions

DART Karaoke Author creates special configuration files (session_name.dka) which contain information 
about the soundfile, the lyrics and the synchronization details. Use the New, Open and Save/Save as 
commands, available from the File menu to start a new session, open an existing session and save 
results under a current/new session name, respectively.
For your convenience the list of most recently opened DART Karaoke Author sessions is provided at the 
bottom of the File menu. To open such sessions simply select them from the list.



Screen areas and controls

Working with DART Karaoke Author, you will come across five different screen areas. These areas are: 
the Menu Bar (providing access to various system functions), the Overview (serving as a graphical 
representation of an entire recording), the Soundfile Window (used to display sound data), the Text 
Window (used to display the lyrics) and a number of control buttons which allow you to `synchronize’ the 
text data with the sound data. 
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Menu bar

The Menu Bar is placed at the top of the DART Karaoke Author main window. It contains several menus 
that provide access to various system functions.

The File menu contains items for managing DART Karaoke sessions (New, Open, Save, Save as), 
running DART Karaoke Wizard (Run Wizard) and for exiting the program (Exit). It allows you to 
provide/get information about the song (File info) and set various program options (Preferences). 
Additionally it shows the list of the recently opened Karaoke sessions.

The Edit menu can be used to undo the recently introduced changes (Undo) and to set synchronization 
Flags (Set flag).

The Soundtrack menu allows you to open (Open) and play (Play all, Play from cursor, Play frame, 
Play window, Stop playing) audio files.

The Lyrics menu allows you to import text files with the song lyrics (Import), to save lyrics in a separate 
text file (Export) and to edit the text (Edit).

The Karaoke menu provides access to different components of the DART Karaoke Studio package that 
will allow you to create your own recording (DeVocalizer, Recorder/Player, Producer) and arrange 
different recordings into playlists (Playlist). Additionally it allows you to run DART CD-Recorder - an 
application you can use to record audio files from different sources and to burn your own CD’s (DART 
CD-Recorder).

Finally, the Help menu can be used to access the DART Karaoke Studio help topics (Contents) and to 
get some general information about the system (About DART Karaoke Author).



Toolbar

The Toolbar is placed immediately beneath the Menu Bar. It contains several buttons that provide an easy
access to the most frequently used system functions. The corresponding items (from left to right) are:

 - open a new DART Karaoke session

 - open an existing DART Karaoke session

 - save a DART Karaoke session

 - run DART Karaoke Wizard

 - open a soundfile

 - import a text file

 - provide/get information about the song

 - run DART Karaoke DeVocalizer (to eliminate the lead vocalist’s performance from a stereo 
recording)

 - run DART Karaoke Producer (to mix your own performance with the soundtrack extracted from 
the original recording)

 - run DART Karaoke Recorder/Player (to watch the song lyrics while listening to the recording 
and/or to record your own vocal performance)

 - open the DART Karaoke Playlist Manager

 - run DART CD-Recorder

 - get access to the DART Karaoke help system





Overview

The strip displayed immediately below the Toolbar is called the Overview. The Overview is a graphical 
representation of the entire soundfile shown in the Soundfile Window. It displays

the current position of the cursor (the yellow vertical line)
the proportion of the material displayed in the Soundfile Window (the black strip)
position of a frame (the green frame)

By placing the mouse pointer anywhere on the Overview strip and depressing the left mouse button you 
can change position of the cursor along with the content of the Soundfile Window. 
To change the proportion of the material displayed in the Soundfile Window use the Zoom box situated on
the left hand side of the Overview (to zoom out/in click the up/down arrow or type in a new value of the 
zoom coefficient).
Finally, to control the size of the frame, place the mouse over the left/right edge of the frame and drag it to
a new position. Note that if the frame is set to be `window-constrained’ (see Frame) you will be not 
allowed to drag the frame edges over the edges of the Soundfile Window.



Soundfile Window

The Soundfile Window displays the plot of a selected fragment of the signal with a desired time resolution.
To open a soundfile choose the Open command available from the Soundtrack menu. You can work with
both uncompressed wave (*.wav) files (preferably) and compressed MPEG (*.mp3) files.
To change resolution of the plot resolution use the Zoom box displayed next to the Overview strip.

In addition to the signal plot the Soundfile Window shows position of the cursor, position of the frame and 
positions of the synchronization Flags – if any.

NOTICE
Note that only the CD-format wave files (16bit, 44kHz, stereo) can be opened in the DART Karaoke 
Author.

Frame
Synchronization flags



Frame

The green Frame displayed on the Overview strip and in the Soundfile Window allows you to precisely 
select the playback range. 
Depending on your preferences the Frame may be window-constrained (i.e., always situated inside the 
Soundfile Window) or unconstrained. To switch between these options use the Preferences dialog 
available from the File menu.
To play the`framed’ portion of the recording, click the Frame button situated in the Play group. To stop 
playback, click the same button again.

The Frame can be modified in two different ways. First, you can drag both frame edges displayed on the 
Overview strip to their new positions (note that if the Frame is set to be window-constrained the edge 
placement will be restricted to the Soundfile Window area). For precise control of the Frame position 
switch to the Soundfile Window and place the mouse pointer over one of the Frame corners – then 
depress the left mouse button and move the corresponding edge to a new position. If the Frame is wider 
than the displayed fragment some or all of its corners may be not available. 
Please note that you can drag the left frame edge over its right edge and vice versa. This feature can be 
very handy when working on consecutive fragments of the sound material.



Synchronization Flags

The Flags displayed in the Soundfile Window are used as the synchronization marks. Depending on the 
selected synchronization level (see Synchronization level) they show the beginning of the sound material 
which corresponds to a particular verse or word. Each Flag has a text banner, a flagpole and a base. To 
move synchronization Flag to a new position, place the cursor over the flagpole and drag it. 
To fix position of a Flag, e.g. to prevent it from accidental displacement, click on its base. The base of a 
fixed Flag is filled with the Flag color. The other Flags cannot move the Flags that are fixed unless their 
status is changed back to `floating’ by clicking the Flag base again. To fix positions of all Flags 
corresponding to a particular verse (including the word Flags) click on the checkbox displayed next to the 
verse number (if you fix all word Flags corresponding to that verse the box will be automatically checked).
If you click on the checked verse box the status of the corresponding Flags will be changed to `floating’. 
Hence, to make all Flags associated with a selected verse floating click the verse checkbox twice – first 
time to fix all Flags (unless they are already fixed) and the second time - to release them.

When you move a Flag to a new position the remaining ones will be pushed away to make a free space, if
necessary (provided, of course, they are not fixed). The distance between the word Flags is limited from 
below by 100 milliseconds. You can change this value using the Preferences dialog available from the 
File menu. 



Text Window

The Text Window shows the lyrics that ought to be synchronized with the music. 

Typesetting rules
If the song lyrics is already typeset and saved in a plain text file you can import it after pressing the 
IMPORT LYRICS button situated on the Toolbar or using the Import command available from the Lyrics 
menu. The typesetting rules are very simple: each verse, which corresponds to one line of a typeset text, 
should consist of a certain number of words and phrases separated by spaces. By phrases we mean two 
or more words joined with underline signs – this is a simple way of linking words which are jointly 
pronounced but written down separately. Multiple spaces are ignored when you import a text but are not 
ignored if you work in the editing mode (to allow you to put a new word between the existing ones). Since 
the verses displayed in the Text Window are automatically numbered, please do not put any numbers at 
the beginning of each line of the typeset text.
If the verse is longer than the width of the Text Window it is displayed in two or more lines. The vertical 
slider situated on the right hand side of the Text Window can be used to scroll the text up and down.

Importing text files
To import an existing text file, press the IMPORT TEXT button situated on the Toolbar or select the Import
command from the Lyrics menu. Then indicate the text file you would like to open.

Exporting text files
The song lyrics is incorporated in DART Karaoke Author files (*.dka). If you want to save it in a separate 
text file use the Export command available from the Lyrics menu. Please note that DART Karaoke 
Author does not update the imported text files – all changes you introduce while working in the text editing
mode are saved in the corresponding *.dka files but are not saved in the original text files. Therefore you 
should use the Export command to save/update such external text files whenever needed.

Providing additional information
If you want to save along with the song lyrics some extra details such as the name of the artist, the album 
title, the song title etc., press the FILE INFO button situated on the toolbar or choose the File info 
command from the Lyrics menu. Then type in song details. A part of this additional information, entitled 
‘short name’, will be displayed at the bottom of the DART Karaoke Recorder/Player window each time the
corresponding song is played.

Text display
The way the text is displayed in the Text Window depends on the selected synchronization level. If the 
synchronization level is set to verse the entire verse is shown in red. If the synchronization level is set to 
word only the first word of each verse is displayed in red and the remaining words are shown in blue. 
The fonts used to display text data reflect the status of each verse – bold letters are used to distinguish all
verses for which the verse Flags are already set.
Depending on the synchronization level the ‘active’ verse or word is marked with a gray frame. To select a
different verse or word, click on the corresponding item. When the text file is synchronized with the audio 
file, the Flag corresponding to the selected item is automatically localized and displayed in the Soundfile 
Window and vice versa – each time a new Flag is activated the corresponding text item is marked.
The checkboxes situated on the left-hand side of the Text Window can be used to fix positions of the word
Flags associated with a particular verse – see Synchronization flags.

Editing a text file
To type in or edit the text, select the Edit command from the Lyrics menu or click on the Text Window 
using the right mouse button and check Edit. As long as you stay in the editing mode a yellow blinking 
cursor is displayed in the Text Window indicating the text insertion point. To quit editing,editing mode 
uncheck Edit in the same way you checked it.



You can type the text while listening to the recording. Using the various play options (All, From cursor, 
Frame, Window), audition specific fragments of the recording as many times as necessary to get the text 
right. Then type it in and move to another fragment. Use the play buttons to audition audio files while 
editing the text as the corresponding keyboard shortcuts are disabled when you enter the editing mode.
Working in the editing mode you can type in a new text or modify the existing one: remove verses and/or 
words, change division into verses and/or words, create phrases etc. If, at the time of editing, the text is 
synchronized with the music, all changes you introduce will be accompanied by Flag changes – the 
corresponding Flags will split or merge, or entirely new Flags will be created. Quite obviously, all new 
Flags (including those created by splitting the existing ones) should be synchronized.



Synchronizing text with music

Text file available
To synchronize text with music when the text file with the song lyrics is available proceed as follows:

1.    Press the OPEN SOUNDTRACK button situated on the Toolbar or use the Open command from the 
Soundtrack menu to open an audio file (wave or MPEG encoded).

2. Press the IMPORT TEXT button situated on the Toolbar or use the Import command from the Lyrics 
menu to import the text file prepared in accordance with the typesetting rules – see Text window.Note 
that at any time you can modify the imported text or correct mistakes.

3. Set the verse Flags during playback: switch off the Play and show option in the Play group, set the 
synchronization level to verse (click the Verse button), place the cursor at the beginning of the 
recording and click All to start playback. Each time you hear the beginning of the verse click the Set 
flag button or press the SPACE bar. Continue until the last verse is reached.

4. When finished, adjust the Flag positions (some small corrections are usually necessary). Fix each Flag 
by clicking on its base to prevent it from accidental displacement (you can move a fixed Flag directly, 
by dragging its pole, but you can’t do it indirectly by moving the neighboring Flags).

5.    When all verse Flags are done, change the synchronization level to word (click the Word button) and 
move the word/phrase Flags to the right positions (to find a Flag click the corresponding word/phrase 
in the Text Window). Fix the Flags when positioning is finished.

If you prefer to perform synchronization in any desired verse order, select the verse you would like to 
synchronize (click on the corresponding fragment of the text) and place the verse Flag by positioning the 
cursor and clicking the Set flag button. Use different play options to determine the right insertion point. 
Repeat this procedure until all verses are synchronized.

At any stage you can verify the synchronization results by playing back the audio with the Play and show
option switched on – if synchronization is done correctly the corresponding verses/words are 
distinguished exactly at the moments they are heard.

NOTICE 1
For an average person it takes approximately 400 milliseconds to react to a sound stimulus. To 
compensate for this ‘response delay’ the Flags dropped during playback are placed in a soundfile with a 
400 ms time shift. To change this time constant, use the Response delay box in the Preferences dialog, 
available from the File menu.

NOTICE 2
For a majority of popular songs the lyrics can be found through the Internet. In most cases it can be 
localized pretty easily by visiting the performer’s homepage or by searching the net for the 
‘performer+lyrics’ combination.

Text file not available
When the text file with the song lyrics is not available you can type it in while listening to the recording. To 
start editing, select the Edit command from the Lyrics menu or click on the Text Window using the right 
mouse button and check Edit. Open the audio file by pressing the OPEN SOUNDTRACK button situated on
the Toolbar or choosing the Open command from the Soundtrack menu. Using the various play options 
(All, From cursor, Frame, Window), audition specific fragments of the recording as many times as 
necessary to get the text right. Then type it in and move to another fragment (all you hip-hop fans may 
find this just a little hard but hang in there guys – just give it some time).
As long as you keep the sequence right you can introduce the text in any desired order, i.e., not 
necessarily starting from the beginning of the song and finishing at its end. You can synchronize each 
verse right after typing it in or you can wait until the entire text is ready and follow instructions given 
above.





Control buttons

The control buttons/boxes situated on the right hand side of the DART Karaoke Author dialog give access
to several important system functions. The Zoom box allows you to change resolution of the signal plot 
displayed in the Soundfile Window. The Set Flag button can be used to set synchronization Flags. 
Controls and buttons contained in the Play group allow you to select the playback mode (Play and Show)
and range (All, From cursor, Frame, Window). Finally, the buttons from the Synchronization level 
group can be used to select between the different synchronization options (Verse, Word).

Zoom
Set Flag
Play
Synchronization level



Changing the plot resolution

The Zoom box, displayed next to the Overview strip, allows you to change the plot resolution and along 
with it - the length of the audio fragment displayed in the Soundfile Window. You can scroll up or down the
zoom coefficient or you can type in any desired value.
Use the Preferences dialog available from the File menu to change the default zoom coefficients 
associated with different synchronization levels.
If you check the AutoZoom box in the Preferences dialog DART Karaoke Author will automatically 
change the zoom coefficient to such one which guarantees that all word Flags belonging to the same 
verse will be displayed in the Soundfile Window when synchronization level is set to word. If the 
AutoZoom box is left unchecked the zoom coefficient will remain constant unless you intentionally modify
its value or change the synchronization level.



Synchronization levels

There are two levels at which you can synchronize the text with the music.
If you choose the verse level, by pressing the Verse button in the Synchronize group, you will be able to 
mark position of the beginning of each verse, that is, each line of the typeset text.
When you choose the word level (available after pressing the Word button in the Synchronize group) 
you will be allowed to mark position of each word or phrase of the text (‘phrase’ is a sequence of linked 
words – see Typesetting rules in Text Window).

When the text file is synchronized with the audio file, the Flag corresponding to the selected item is 
automatically localized and displayed in the Soundfile Window and vice versa – each time a new Flag is 
activated the corresponding text item is marked.



Playing audio files

After opening an audio file you can play it in several different ways.

To start playback click one of the buttons situated in the Play group or use the corresponding keyboard 
shortcuts. You can stop playback in two different ways. If you click the Stop button (each play button turns
into Stop when activated) or press S, the playback will be stopped and the cursor will return to its initial 
position. If you press ESC during playback, the cursor will stay in its last position.

To play the entire audio file, click the All button situated in the Play group or press A.
To play an audio file from the current cursor position, click the From cursor button or press C. The cursor 
position can be changed by clicking on the Overview strip or anywhere inside the Soundfile Window. 
If you click Frame or press F the contents of the green Frame will be played back.
Finally, if you click Window or press W, the playback will be limited to the contents of the Soundfile 
Window. 
Note that changing the cursor position during playback takes the playback to a new location.

To check synchronization results, activate the Play and show option by clicking on the corresponding box
in the Play group. When the Play and show option is switched on the currently played verse or word is 
highlighted in the Text Window in accordance with its Flag position. To drop the verse Flags during 
playback (at the initial stage of synchronization) switch the Play and show option off.



Using DART DeVocalizer

DART DeVocalizer is available after pressing the DEVOCALIZER button situated on the Toolbar or after 
choosing the DeVocalize command from the Karaoke menu.
You can use this tool for elimination or near-elimination of the lead vocalist’s performance from almost 
any regular stereophonic recording. This is like producing a Karaoke music track except that the 
background music and background vocals are not an imitation – they are extracted from an original 
recording by means of digital processing of an audio signal. And you don’t have to wait for someone to
prepare it for you!
Basically, all stereo audio sources can be used: compact disks (usually yielding the best results), 
analog records, cassette tapes, stereo TV and Radio etc. The separation technique will not work on a 
monophonic source. Also, it usually does not work on recordings made before the mid-1960s.

Tuning DeVocalizer
To enforce the largest suppression rate keep the Attenuation slider in its rightmost position. The result
depends on the amount of reverberation present in the original recording. If there is a lot of ambient 
sound associated with the lead vocalist the elimination will not be perfect. Even in this case, however, 
the remaining ‘echo’ should be pretty faint.
The voice of the lead vocalist is often eliminated along with the sound of some of the supporting 
instruments. To minimize this effect use the Bass retrieval slider – while listening to the results 
increase the bass cutoff by moving the Bass retrieval slider to the right. Stop right about the point 
where the vocal track becomes audible again. The bass    retrieval is usually worth the effort as it can 
bring back some important elements of the accompaniment suppressed in the course of vocal 
elimination, such as percussion beats, bass guitar and generally all sounds that remain below the lead 
vocalist’s ‘bandwidth’.
Use the Output level slider to control the volume of the devocalized sound. When adjusting the 
volume make sure that the clip indicator does not lit.

When over-dubbing someone’s performance a little bit of help from the lead vocalist may be not a bad 
idea. Well, it is simpler than you think – just move the attenuation slider to the left to reduce the 
suppression rate and ... let Michael Jackson help you as a support vocalist!

On-line tuning
To perform on-line tuning, select the processing range using the Range box. You can process the entire 
recording, starting from its beginning (entire file) or from the current position of the cursor in the Soundfile 
Window (from cursor). If you choose frame, all tests will be confined to a selected frame; and if you select 
window they will be confined to the content of the currently displayed window. In all cases listed above, 
processing is performed in a loop. Note that you can shift back and forth between DART Karaoke Author 
and DART DeVocalizer. This allows you to change the content of the signal Frame and/or Soundfile 
Window without closing the DART DeVocalizer dialog.
To start the test press the Play result button. DART DeVocalizer will allow you to listen to the results of 
digital audio processing while changing the program settings. Each time you modify any of the settings, 
the red Ready light situated in the Audition group will go off - it will be switched on again as soon as the 
results obtained under the new settings are available. At any time during the test you can press the Play 
source button to bypass filtering and listen to the original recording. 

Saving results
When tuning is finished you can process the entire soundfile and save the results in a separate soundfile. 
To start processing press the Process button. To change the name of the output file press the Change 
button and type in a new name.
When the output (devocalized) file is produced you can display it in the Soundfile Window by clicking the 
radio button situated next to its name. Playing the devocalized soundfile in the Play and show mode you 
can perform a ‘dress rehearsal’ prior to using the DART Karaoke Recorder/Player.



NOTICE
When the bass/treble retrieval options are switched off DART Karaoke Author creates a pseudo-stereo 
output file (the left channel is the reversed-phase version of the right channel). When the retrieval options 
are active the output file is truly stereophonic.



Set song info

Type in information that will be saved along with the song lyrics and synchronization details: the name of 
the artist, the album title, the song title etc. A part of this additional information, entitled ‘short name’, will 
be displayed at the bottom of the DART Karaoke Recorder/Player window each time the corresponding 
song is played.



Creating a playlist

To combine a number of DART Karaoke sessions into a playlist, evoke the Playlist dialog by pressing the
PLAYLIST button situated on the Toolbar or by selecting the Playlist command from the Karaoke menu. 
Use the Add, Remove, Move up and Move down buttons to arrange DART Karaoke sessions into a new
playlist. To clear the playlist, click the Clear button and to open a selected session for inspection of its 
contents, press the Open button.
To save a playlist, press the Save button and to open an existing playlist click the Load button.
Finally, to play the playlist click the Play button.



Using DART Karaoke Recorder/Player

DART Karaoke Recorder/Player allows you to

watch the song lyrics while listening to the recording
record your own vocal performance

To evoke the program, press the RECORDER/PLAYER button on the Toolbar or select the 
Recorder/Player command from the Karaoke menu. Before entering DART Karaoke Recorder/Player 
you have to decide which audio file should be played (prior to using Recorder/Player you have to 
synchronize the text with the music and save the results in a special DART Karaoke Author session file 
*.dka). You can choose among the original (unprocessed) soundfile, its devocalized version or any other 
file ‘derived’ from the original. The third option can be used to select between different versions of a 
devocalized source, corresponding to different DeVocalizer settings. If you plan to record your own audio 
track, select the name of the output file (‘My vocal file’). If you check the Open Producer when finished 
box the DART Karaoke Producer will be automatically called each time you quit Recorder/Player.

Playing audio
You can use DART Karaoke Recorder/Player to play audio files and watch the text at the time it is sung or
spoken. This feature can be very useful when learning foreign languages or trying to follow song lyrics in 
a language you don’t know very well.
To start playback, press the PLAY button at the bottom of the screen. To pause playback, press the 
PAUSE button. To resume playback after pausing, click the PAUSE button again. Finally, to stop playback 
press the STOP button.
If you want to play several audio files, evoke the Playlist dialog by pressing the PLAYLIST button situated
on the Toolbar or by selecting the Playlist command from the Karaoke menu. Use the Load button to 
open an existing playlist or use the Add, Remove, Move up, Move down and Clear buttons to arrange 
DART Karaoke sessions into a new playlist. When ready, click the Play button to evoke DART Karaoke 
Recorder/Player and start playback. The name of the currently played item is shown at the bottom of the 
Recorder/Player screen. To move to the next or previous item, click the NEXT or the PREVIOUS button, 
respectively. Finally, to display and/or to choose from the contents of the entire playlist, click the silver 
triangle situated at the bottom of the screen. 

Recording audio
In order to record your own vocal track while listening to the music your audio card must be Full Duplex 
which means it should allow for simultaneous handling of the input and output data streams.
To record do the following

1. Connect the microphone to the MIC input of your audio card.
2. Connect headphones to the output of your audio card (if you used loudspeakers, in addition to your 

voice the microphone would also pick some amount of the background music).
3. Put on the headphones and press the RECORD button to start the recording session. When singing 

don’t hold the microphone too close to your mouth – otherwise you may introduce into the recording 
some low frequency breathing artifacts (‘air pops’). To pause recording press the PAUSE button. To 
resume recording after pausing click the PAUSE button again

Recording will be automatically stopped when the end of the input audio file is reached.

NOTICE
When recording your own vocal contribution you can listen either to the original recording (i.e., sing along 
with the performer you would like to over-dub) or to the devocalized recording.





Add Lyrics

If the lyrics is already typeset and saved in a text file, import it. Otherwise type it in while listening to the 
song.
To edit an existing text, import it. Then move to the previous screen (press the Back button) and enter the
typesetting mode.



Edit Lyrics

Type in the text while listening to the song. 
Use the Play button to listen to specific fragments of the recording. To repeat playback after stopping, 
click the Play button again. To play the next fragment, click Continue. 
The typesetting rules are simple. Each verse should consist of a certain number of words separated by 
spaces. The words that are jointly pronounced, but written separately, can be linked using the underline 
characters. To start a new verse, press ENTER. If a verse is longer than the width of the Text Window it is 
displayed in two or more lines. The verses are automatically numbered.



Synchronize

Use this function to synchronize song lyrics with the music.
You can proceed in two different ways:

Approach 1: All at once (recommended)
Make sure that the yellow cursor shown on the Overview strip is in its leftmost position. Start playback.
Each time you hear the beginning of a verse click the Set flag button, or press the SPACE bar. Continue 
until the last verse is reached.

Approach 2: Step by step 
Click on a particular verse in the Text Window. Then use the Overview strip to localize the corresponding 
fragment of the recording and place the cursor at its beginning. When done click the Set flag button. 
Continue until all verses are synchronized.

NOTICE
Only crude synchronization is possible in the guided mode. To synchronize individual words and/or to 
adjust positions of synchronization Flags close the Wizard and follow synchronization instructions, which 
can be found in the Help files.



Devocalize

Use this tool for elimination or near-elimination of the lead vocalist’s performance from almost any regular 
stereophonic recording.
The quality of the devocalized sound is usually much better if the recording is not compressed. 
The separation technique will not work on a monophonic source.



View

Learn how to 'view' different fragments of the soundfile. 
Change cursor position by clicking on the Overview strip or by clicking inside the Soundfile Window. Move
the slider placed beneath the Soundfile Window. Change the plot resolution using the Zoom box.
Check the AutoZoom box in the Preferences dialog, available from the File menu, and set the 
synchronization level to word. Observe how DART Karaoke Author automatically adjusts the zoom 
coefficient to such one which guarantees that all word Flags belonging to the same verse are displayed in
the Soundfile Window. Switch off the AutoZoom mode. If the AutoZoom box is unchecked the zoom 
coefficient remains constant unless you intentionally modify its value or change the synchronization level.



Play

Learn how to play different fragments of the soundfile. 
To start playback click one of the buttons situated in the Play group or use the corresponding keyboard 
shortcuts. You can stop playback in two different ways. If you click the Stop button (each play button turns
into Stop when activated) or press S, the playback will be stopped and the cursor will return to its initial 
position. If you press ESC during playback, the cursor will stay in its last position.

To play the entire audio file, click the All button situated in the Play group or press A. 
To play an audio file from the current cursor position, click the From cursor button or press C. The cursor 
position can be changed by clicking on the Overview strip or anywhere inside the Soundfile Window. 
To play the contents of the Soundfile Window, click the Window button or press W.
Finally, to play the contents of the green Frame, click Frame or press F. Learn how to change the frame 
coordinates by dragging its corners (in the Soundfile Window) or by dragging its edges (on the Overview 
strip).
Note that changing the cursor position during playback takes the playback to the new location.



Synchronize

Learn how to use synchronization markers (Flags).
Set the synchronization level to 'verse'. Click on different verses in the Text Window and observe the 
corresponding changes in the Soundfile Window. Do the same after changing the synchronization level to 
'word'.
Click on the poles of different Flags displayed in the Soundfile Window. Observe how different 
verses/words are selected in the Text Window when you switch from one Flag to another. 
Move synchronization Flags displayed in the Soundfile Window by dragging their poles. Since the boxes 
displayed next to the verse numbers are checked, all Flags are fixed, i.e. they can be moved directly, by 
dragging their poles, but can’t be moved indirectly, by moving the neighboring Flags (fixing prevents Flags
from accidental displacement). To change the status of all Flags belonging to a given verse to ‘floating’, 
click on the corresponding box. Now you can freely move the Flags to desired positions. Change the 
status of a Flag from ‘fixed’ to ‘floating’ and vice versa by clicking on its base (the base of a fixed Flag is 
filled with the Flag color).
Change the playback mode to 'Play and show' and observe how different verses/words are highlighted 
during playback.



Edit

Learn how to edit the text displayed in the Text Window. Your changes will not be saved so you can 
experiment freely.
To start editing, click on the Text Window using the right mouse button and check Edit or select the Edit 
command from the Lyrics menu
Try to modify the song lyrics: place the cursor anywhere in the text window and make changes e.g. 
edit/remove the existing words or add the new words. Observe how synchronization Flags change 
according to your modifications.
To exit the editing mode click the Edit command again. And note: when you open the learning session 
again the original text will be restored.



Devocalize

Learn how to eliminate the lead vocalist's performance from a stereophonic recording.
Click the Devocalize button situated on the toolbar.
Use the attenuation slider to control the voice suppression rate.
The voice of the lead vocalist is often eliminated along with the sound of some supporting instruments 
such as percussion, bass guitar etc. Use the Bass retrieval slider to minimize this effect – while 
listening to the results increase the bass cutoff by moving the Bass retrieval slider to the right. Stop 
right about the point where the vocal track becomes audible again. 
Use the Output level slider to control the volume of the devocalized sound. When adjusting the 
volume make sure that the clip indicator does not lit.
Switch between Play source and Play result to compare the original recording with its devocalized 
version.



Using DART CD-Recorder Lite

DART CD-Recorder Lite, available after pressing the CD-RECORDER button situated on the Toolbar, or 
after choosing the DART CD-Recorder command from the Karaoke menu, is an application that allows 
you to record audio files from different sources (tape deck, reel-to-reel, phonograph, CD player, MIDI 
mixer, MPEG 3 codec), combine them into a sequence called playlist and - if your computer is equipped 
with a compact disk recorder (CD-R) - to record your own CD. 

If you need more information on any of the DART CD-Recorder Lite functions, select one of the topics 
listed below:

About DART CD-Recorder Lite
About online help system
Screen areas
Menus
Toolbar
Creating, managing and listening to the playlist
Printing the playlist
Recording from an analog source
Unpacking audio collections
Processing audio files
Using DirectX Audio Plug-Ins
Recording from an audio CD
Using CDDB
Recording MIDI
Recording MPEG Audio
Creating your own CD

How to ...



About DART Karaoke Studio

Feel like performing songs of your favorite singers – Britney Spears? George Michael? Madonna? 
Backstreet Boys? No problem! There is no need to purchase special recordings of popular songs with the 
voice removed or to buy an expensive Karaoke machine to record your own performance. DART Karaoke
Studio will turn your home computer into a small recording studio allowing you to over-dub performance of
your favorite artists.

DART Karaoke Studio is a package that allows you to

 record audio files from different sources (DART CD-Recorder)
 eliminate the lead vocalist’s performance from almost any regular stereophonic recording (DART 

DeVocalizer)
synchronize the song lyrics with the `devocalized’ soundtrack so that the text will be displayed right at 

the time it can be heard in the original recording (DART Karaoke Author)
record your own version of the vocal track (DART Karaoke Recorder/Player)
mix your own performance with the soundtrack extracted from the original recording (DART Karaoke 

Producer)
burn your own CD (DART CD-Recorder)

All you need to use the DART Karaoke Studio is a stereo audio WAVE (strongly recommended) or MPEG 
file with the original recording. 
WAVE (*.wav) is a standard uncompressed audio format used in all Windows applications. If you don’t 
have the wave source of your favorite recording DART CD-Recorder will allow you to record a wave file 
from an analog source (phonograph, tape deck) or to create it from a selected audio CD track (if you have
a choice always use the second opportunity). 
MPEG Audio (*.mp3) is a special tool for reducing the size of audio files. A lot of the MPEG compressed 
audio files, along with the audio CD-related data, such as song lyrics, can be found in the Internet.

NOTICE 1
DART Karaoke Studio neither reads nor creates the MIDI Karaoke files (*.mid). The two systems work in 
entirely different ways. When you use the MIDI Karaoke, the soundtrack is synthesized using the MIDI 
(Musical Instrument Digital Interface) interface. When you use DART Karaoke, the soundtrack is 
extracted from the original stereo recording by means of suppressing the vocal part.

NOTICE 2 
The quality of the devocalized sound is usually much better if the original recording is not compressed. 
When MPEG files are processed some specific disturbances may (but must not) be generated ranging 
from a very faint high frequency hum to loud pops and clicks. All such artifacts are the side effects of 
signal compression (the stronger the higher the compression rates) and, unfortunately, cannot be 
eliminated. Since they never occur if the original, i.e., uncompressed audio is processed, we strongly 
recommend that you work with wave files.

To obtain more information on any of the DART Karaoke Studio functions, select one of the topics listed 
below: To evoke context help press F1.

About DART Karaoke Studio
About DART Karaoke Wizard
How to create your own recording
Using DART Karaoke Author
Using DART DeVocalizer
Using DART Karaoke Recorder/Player
Using DART Karaoke Producer



Using DART CD-Recorder
Creating a playlist
Minimum system requirements



Minimum system requirements

To run DART Karaoke Studio, your computer must meet the following minimum system requirements

1. Pentium-class processor running at least 200 MHz
2. 800x600 video screen resolution, 16 bit color
3. 16 Mbytes RAM
4. 100+ Mbytes free hard disk space
5. Full Duplex sound card (the one that allows for simultaneous handling of the input and output data 

streams) – for recording purposes only
6. Microphone and speakers



Using DART Karaoke Producer

When both pieces needed to create a new recording are ready, namely a devocalized soundtrack 
(obtained using the DART DeVocalizer) and an audio track with your own vocal performance (created 
using the DART Karaoke Recorder/Player), it’s time for mixing it up.
DART Karaoke Producer allows you to combine the two sources mentioned above in any desired 
proportion. To open the Producer dialog, press the PRODUCER button situated on the Toolbar or select the 
Producer command available from the Karaoke menu. Then select the input audio files. The gain sliders 
situated in the Balance group allow you to independently set the volume for each audio source – you can 
use this option to compensate the recording level differences, for example. You can either increase or 
decrease the volume of each audio track by moving the corresponding slider upwards or downwards, 
respectively. If the slider stays in its middle (‘zero’) position the volume remains unchanged. When 
selecting the mixing proportions keep an eye on the clip indicator. Clipping occurs when the level of the 
output (mixed) signal is too large. Since it may result in audible signal distortions it should be avoided (to 
eliminate clipping move one or both gain sliders downwards). 
In order to reverse the phase of the mixed signals check the corresponding Invert boxes.
Use the various Preview options to set the balance between the combined tracks. You can play each of 
the input soundfiles separately (Play file 1, Play file 2) or listen to the combination (Play result). Use the 
Range list to set the desired playback range (Entire file, From cursor). To change the cursor position 
click on the Overview strip at the top of the Producer dialog.
When the balance is set, select the name of the output file and press Process to start processing.



How to create your own recording

To create your own recording:

1.    Start DART Karaoke Author and open the WAVE (preferably) or MPEG stereo audio file with the 
original version of the song – see Soundfile Window. If necessary, use DART CD-Recorder to record 
audio from an analog (tape deck, phonograph) or digital (CD player) source - see Using DART CD-
Recorder.

2.  Import the text file with the song lyrics or, if not available, type in the text while listening to the 
recording – see Text Window.

3.    Use the DART Karaoke tools to synchronize text with music – see Synchronizing text with music.
4.    Use DART DeVocalizer to remove the vocal part of the recording – see Using DART DeVocalizer.
5.    Use DART Karaoke Recorder/Player to record your own vocal track – see Using DART Karaoke 

Recorder/Player.
6.    Use DART Karaoke Producer to combine the devocalized soundtrack extracted from the original 

recording with your own vocal performance – see Using DART Karaoke Producer.
7.    Use DART CD-Recorder to burn your own CD - see Using DART CD-Recorder.

It’s easy. It’s fun!



About DART Karaoke Studio

Digital Audio Restoration Technology
DART Karaoke Studio[TM]
Designed by Piotr Kuzora and Maciej Niedzwiecki
Copyright 2000 DARTECH, Inc., another subsidiary of ZH Computer, Inc.
www.dartpro.com

MP3 support by PlayMedia Systems, Inc.
www.playmedia.hr



About DART Karaoke Wizard

When you start DART Karaoke Studio, the Karaoke Wizard dialog appears on the screen. The Wizard 
was designed to guide you, step by step, through the entire DART Karaoke session. Some more 
complicated functions, such as low level synchronization or frame handling, are not available in the 
guided mode. To use these functions, you should close the Wizard dialog and follow instructions that can 
be found in program documentation (available after pressing the HELP button situated on the Toolbar).
To bring back the Wizard dialog, click the WIZARD button situated on the Toolbar or select the Run 
Wizard command from the File menu.




